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En este documento se va a explicar como crear un proyecto en KiCad, el resultado final será 
una réplica de la tira de LEDs de abierto.cc 
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1.  Esquema 

Abrir KiCad y crear nuevo proyecto. 
 

 
 
A continuación tendremos que elegir un nombre para el proyecto y un lugar donde va a ser 
guardado. 
Una vez hayamos hecho esto, automáticamente KiCad crea un archivo para la creación del 
esquema del circuito que queremos fabricar, de extensión “.sch” y otro de en el que vamos a 
crear el diseño del PCB, de extensión “.kicad_pcb”.  Ambos cuelgan de un archivo “.pro” 
El primer paso es crear el esquema del circuito vamos a fabricar, por lo que vamos a empezar 
por modificar el archivo de extensión .sch. 

Para ello, tenemos que abrir Eescheema.       
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En este momento, el primer paso es darle un nombre a nuestro esquema y seleccionar un 
tamaño de página, para ello vamos a File -> Page Settings y fijamos el tamaño de la hoja a A4 
y le damos un título al esquema: LEDs Strip. 
 

 
 
 

Colocado de componentes 
 
Una vez hecho esto, vamos a empezar a colocar los componentes, para este proyecto se 
necesitan: 

● 8 LEDes 
● 1 Tira de 9 pines 
● 2 Array de resistencias 

Para seleccionar el componente que queremos utilizar debemos seleccionar la opción Place 
Component, en la parte derecha de la pantalla. 
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A continuación hacer clic en cualquier lugar de la hoja del esquema y saldrá un menú donde 
buscar los componentes 
 

 
 
 
 
 
 

Empezando un proyecto con KiCad J. García - abierto.cc  

Sujeto a la licencia Reconocimiento-NoComercial-CompartirIgual 4.0 Internacional de Creative Commons
 

 

https://creativecommons.org/licenses/by-sa/4.0/


5 

En este menú buscaremos: 
- LED para encontrar los LED que necesitamos y seleccionaremos la opción LED [LED 

Generic] 
- Conn  para buscar la tira de pines y seleccionaremos la opción CONN_01x09 

[Connector, Single row, 1x09] 
 
Algunas de las acciones más comunes que se pueden hacer con los componentes son: 

- Mover (Letra M) : Cambiar la posición de un componente que ya había sido colocado. 
- Copiar (Letra C): Copiar componente. 
- Editar Referencia (Letra U): Cambiar la referencia que asigna al componente. 
- Editar Valor (Letra V): Cambia el valor del componente. 
- Footprint (Letra F): Asignar o cambiar el footprint del componente. 
- Editar Componente (Letra E): Menú en el que aparecen todas las cosas editables del 

componente. 
- Rotar (Letra R): Girar componente. 
- Mirror X (Letra X): Girar el componente en forma de espejo en el eje X 
- Mirror Y (Letra Y): Girar el componente en forma de espejo en el eje Y 
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Una vez seleccionados los componentes que necesitamos, los tenemos que colocar en la 
página construyendo el esquema de conexiones, el resultado debe ser similar al mostrado a 
continuación: 
 

 
 

El componente que nos queda por colocar no tiene un footprint en las librerías de KiCad, para 
utilizarlo existen dos opciones: 

1. Utilizar el footprint de un conector de 5 pines, ya que el pitch (distancia entre pines) del 
array de resistencias que vamos a usar y el del conector es el mismo. 

2. Crear el componente. 
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Crear nuevos componentes  

En nuestro caso, vamos a crear el componente. Para ello vamos a utilizar el library editor  
en la parte superior de la pantalla. 
 

 
 

Una vez dentro del library editor vamos a seleccionar la opción: “Create a New Component”

. Al seleccionarla, nos aparecerá una ventana en la que le asignaremos a nuestro 
componente el nombre “ResistorArray” y pulsaremos “Aceptar”. 
Al hacer esto, en el editor de componentes aparecen el nombre del componentes y la 
referencia: U?. 
 
A continuación vamos a crear el componente, en primer lugar, vamos a colocar los terminales. 

Para ello, pulsamos en “Add pins to component”  .  
 

 
 

De esta forma vamos a añadir los 5 terminales que necesita nuestra red de resistencias, vamos 
a etiquetar cada terminal con la siguiente nomenclatura: 
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Nombre Número 

GND 1 

R1 2 

R2 3 

R3 4 

R4 5 

 

 
 
Una vez que hemos colocado todos los terminales, vamos a darle forma al componente, esto lo 
vamos a hacer pulsando en la opción “Add lines and polygons to component body” del menú de 

la derecha  . 
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Con la herramienta de líneas seleccionada, vamos a fijar un punto de inicio y haciendo clic con 
el botón izquierdo haremos las esquinas del componentes. Para finalizar la forma del 
componente, haremos doble clic con el botón izquierdo. 
 
Antes de guardar, vamos a añadir al componente una descripción, para hacerlo, nos vamos a 

“Edit component properties”  en la barra de herramientas superior y añadimos el siguiente 
texto: 
 

 
 
Para guardar el nuevo componente, creamos una carpeta de nombre “componentes” en la 
carpeta contenedora del proyecto. Una vez creada la carpeta, seleccionamos la opción “Save 

current component in a new library”   del editor. Al clicar en esta opción aparecerá una 
ventana, en la que tendremos que seleccionar la ruta de la carpeta “componentes” y “Aceptar”. 
 
¡Ya hemos creado nuestro array de resistencias! 
 
Llegados a este punto, aparecerá la siguiente ventana emergente, que nos avisa de que para 
utilizar el componente que acabamos de crear primero tenemos que añadirlo en el proyecto. 
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Para añadir el componente, ya desde la ventana de Eeschema, vamos a seguir los siguientes 
pasos: 

1. Preferences -> Component Libreries 
2. Component library files -> Add ( y buscamos “resistorarray.lib” en la ruta de la carpeta 

“componentes” que anteriormente creamos” 
3. User defined search path -> Add (al clicar Add nos llevará a la carpeta “componentes”), 

“Aceptar”. 
 
Con estos pasos ya hemos añadido el componente al proyecto y podremos buscarlo tal y como 
hemos hecho con los demás componentes anteriormente. 
 

Haciendo las conexiones 
 
Con todos los componentes colocados en la pantalla, el siguiente paso es hacer las 

conexiones. Para ello seleccionamos “Place wire”  . 
 

 
 
Para terminar con el esquema, lo único que falta es añadir las referencias del circuito “GND”, 

para ello buscamos en la pestaña de “Place power port”  . 
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Llegados a este punto, sería buena idea guardar el trabajo realizado. 
 
 
Terminado el esquemático y antes de empezar con el PCB, tenemos que asignar la referencia 
que permita distinguir entre cada uno de los componentes que hemos utilizado y asignarles un 
footprint. 

Para asignar la referencia, vamos a pulsar “Annotate schematic components”  , al pulsar 
aparecerá una ventana que nos da opciones, de las que se puede seleccionar las que mas 
adecuadas veamos para nuestro esquema, en este caso vamos a seleccionar: 
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Una vez seleccionadas, pulsamos annotate y a continuación, podremos comprobar cómo en las 
referencias de los componentes que hemos utilizado se ha sustituido el “?” por un número. 
 

Cómo hacer huellas (footprint) de componentes 
 
Antes de asignar el footprint a los componentes que hemos utilizado, vamos a crear el footprint 
del array de resistencias que hemos creado. Para ello, en la ventana principal de KiCad, vamos 

a pulsar sobre el icono de “PCB footprint editor”  . 
 

 
Igual que hicimos a la hora de crear un componente, el primer paso es seleccionar la opción 

“New Footprint”   en la barra de herramientas superior de la ventana. Al seleccionar esta 
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opción, aparece una ventana emergente donde nos pide que le demos un nombre a nuestro 
footprint, vamos a utilizar el mismo nombre que le dimos al componente: “ResistorArray”. 
 

 
 

Al pulsar “Aceptar”, nos aparecen en la ventana de forma automática dos textos: 
- Nombre del componente: ResistorArray (en color amarillo: capa F.FAb) 
- Referencia del componente: **ref (en color azul: capa de silk) 

 

 
 
A continuación, vamos a colocar los taladros que necesitamos para poder colocar el 
componente en el PCB, para ello tenemos que conocer la separación entre los pines del 
componente y el diámetro de las patas del mismo. En nuestro caso vamos a utilizar los 
siguientes valores: 

- Pitch = 2,54 mm 
- Diametro = 0,8 mm 

Para colocar los taladros, vamos a seleccionar la opción “Add pads”  , en la parte superior 
de la barra de herramientas lateral derecha del editor de  footprints. 
 
Llegados a este punto, tenemos dos opciones: 

- Poner el primer pad como punto de referencia del componente 
- Poner el centro del componente como referencia 

En este caso vamos a elegir la segunda opción porque nos ofrece simetría a la hora de rotar y 
mover el componente. 
Como nuestro footprint tiene 5 pines y vamos a utilizar el centro del componente como 
referencia, vamos a situar el primer taladro en las coordenadas (0,0). 
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Para ello, en primer lugar, situamos el taladro en cualquier parte de la pantalla y situando el 
ratón sobre él, pulsamos la tecla “E” para que nos aparezca la siguiente ventana de 
características: 
 

 
 

En ella vamos a cambiar: 
- Pad number : 3 
- Position X: 0 
- Position Y: 0 
- Size X: 1,6 mm (el doble del diámetro del drill, relación que aparece por defecto) 
- Drill -> Size X: 0,8 mm. 

 
Una vez colocado el primer componente, vamos a mover los textos que nos aparecieron al 
principio a un lugar provisional, donde no nos molesten para crear el footprint. Después, 
procederemos de la misma forma que hicimos con el primer taladro. 
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Los taladros 2 y 4, estarán a la misma distancia del centro: -2,54mm y 2,54mm 
respectivamente. 
 

 
 
Los taladros 1 y 5, estarán al doble de separación que el 2 y el 4, es decir, 2,54*2 = 5,08mm 
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Como se puede apreciar en la imagen anterior, el taladro 1 tiene diferente huella que los 
demás, hacemos esto para diferenciar de una forma clara cuál es la pata número 1 del 
componente, que en este caso, corresponde con el terminal común del array de resistencias. 
Para cambiar la forma de la huella, solo tenemos que cambiar el “Shape” como se ve en la 
siguiente imagen: 
 

 
 

A la hora de diseñar circuitos, es una buena práctica, que el terminal común o negativo de los 
componentes coincida con el PAD cuadrado o diferente del footprint, esto nos facilitará su 
colocación a la hora de soldarlos. 
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El siguiente paso en la creación del footprint es dibujar el perímetro del componente, para ello 

vamos a seleccionar la opción “Add graphic line or polygon” del menú de la derecha   y 
vamos a dibujar un rectángulo alrededor de los taladros que hemos colocado. Antes de 
empezar a dibujar, tenemos que seleccionar la capa sobre la que queremos que situar el 
polígono, vamos a seleccionar, en primer lugar “F.SilkS”: 
 

          
 

Y una vez que tengamos el rectángulo en F.SilkS, vamos a repetir el paso en la capa “F.FAb” 
 

          
 

Conviene, que el rectángulo que hemos dibujado se aproxime lo máximo posible al tamaño real 
del componente que vamos a utilizar, de este modo, nos ayudará a saber cómo de cerca 
podremos colocar otro componente a la hora de crear nuestro PCB. 
 
Llegados hasta aquí podemos aproximar los textos al componente para que no estén muy lejos 
de él y nos sirvan como referencia a la hora de colocarlo en PCB. 
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Para terminar, solo tenemos que guardarlo. Para ello, vamos a utilizar la opción “Create new 

library and save current footprint”   en el menú superior del editor. 
 
Al pulsar, nos aparecerá una ventana emergente que nos pedirá un destino y un nombre para 
nuestra librería. En este punto, recordar, que si guardamos la librería en una carpeta y 
posteriormente la cambiamos de sitio, no podremos volver a usarla a menos que la volvamos a 
añadir, de modo que, se recomienda guardarla en una carpeta específica para librerías que no 
vaya a ser movida. 
 

 
 
Una vez seleccionado el nombre y el destino seleccionamos “Aceptar” y ya tenemos el foprint 
para nuestro componente. Ahora solo queda añadirlo para que pueda ser usado. 
 

Añadir librerías con footprints 
 
A medida que vayamos diseñando PCB, iremos utilizando diferentes componentes, cuyos 
footprints no siempre van a estar incluidos en las librerías básicas de KiCad. Es posible que 
tengamos que crear nuevas librerías o que encontremos librerías con múltiples componentes 
que contengan lo que necesitamos. Para poder utilizarlas tenemos que añadirlas a nuestros 
proyectos. Para ello, vamos a seguir los siguientes pasos:  
 

Abrimos PCBnew en la ventana principal de KiCad   . Una vez abierto, seguimos la 
siguiente ruta: Preferences -> Footprint Libraries Wizard. 
 
En la pantalla emergente que aparece, clicamos “Next” y a continuación buscamos la carpeta 
donde hemos guardado nuestra librería. 
 
Cuando hayamos seleccionado la carpeta correspondiente, clicamos “Next”. Si la librería es 
válida, en la siguiente ventana aparecerá un “OK” en la casilla de “Status”, solo nos restará 
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hacer click en “next” e indicar si queremos añadir la librería de forma global o solo para este 
proyecto y clicar en “finish”. 
 
Hecho esto, podemos utilizar el footprint que hemos creado en nuestros proyectos. 
 
La secuencia de pasos descrita se muestra en las siguientes 4 imágenes: 
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Asignado de footprints 
 
Para asignar footprint a los componentes utilizados seleccionamos: “Run CvPcb to asociate            

components and footprints”.   
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En la ventana que aparece a continuación, vamos a asignar los siguientes footprints a los 
componentes: 
 

Componente Footprint 

LED LEDs: LED_5.00mm 

Array de resistencias ArrayResistor (footprint que acabamos de crear) 

Conector Pin Headers: Pin_Header_Straight_1x09_Pitch2,54mm 

 

 
 
Cuando hayamos asignado footprint a todos los componentes guardamos y cerramos. 
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Generar archivos para crear PCB 
 
De vuelta en Eeschema, tenemos que generar una NETLIST, que será utilizada para 
establecer las conexiones entre componentes en el PCB, y también un archivo BOM o “Bill Of 
Materials” en el que se lista cada uno de los componentes que hemos utilizado. 
 
Para generarlos, en primer lugar vamos a pulsar sobre la pestaña “Generate Netlist” y vamos a 
seguir los siguientes pasos: 

1. Generate  
2. Guardar 

Esto creará un archivo con el nombre de nuestro proyecto y extensión .net en la carpeta 
contenedora. 
 
En segundo lugar vamos seleccionar la pestaña “Generate Bill of materials and/or cross 
references”. Para generar el BOM nos hace falta añadir un plugin en la ventana que aparece. 
Para generar dicho plugin: 

1. Clicamos en Add Plugin 
2. Buscar el plugin de nombre : ”bom2csv” en la ruta /usr/lib/kicad/plugins/ 
3. Sustituir el texto que aparece por defecto en el recuadro Command Line por: 

xsltproc -o " %O.csv" "/home/<user>/kicad/eeschema/plugins/bom2csv.xsl" " %I" 
4. Generate. 

Al seguir estos pasos se van a generar archivos en la carpeta contenedora con extensión .xml y 
.csv 
 
A continuación, guardamos nuestro esquema y estamos listos para empezar a diseñar nuestro 
PCB. 
 

2.  PCB 
Para empezar con la edición de nuestro PCB, tenemos que abrir, desde la ventana principal de 

KiCad, PCBnew  .  
Igual que hicimos con el esquema, el primer paso en la creación del PCB, es darle un nombre y 
seleccionar un tamaño de página, para ello vamos a File -> Page Settings y fijamos el tamaño 
de la hoja a A4 y le damos un título al esquema: LEDs Strip. 
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Bordes de placa 
 
A continuación tenemos que delimitar el espacio en el que vamos a fijar los componentes, es 
decir, delimitar los bordes de nuestra placa. En caso de que queramos una placa con una 
forma básica, se puede crear desde el editor de PCB (PCBNew). 
 
Para ello tenemos que seleccionar la capa Edge.Cuts y la opción “Add graphic line or polygon”. 
 

 
 
Para diseños de bordes de placa más elaborados y, por tanto, difíciles de hacer utilizando el 
método anterior, existen otras opciones. 
A continuación vamos a explicar dos formas diferentes de añadir a PCBNew un borde de placa 
creado con inkscape. 
 

Borde de placa como componente 
En primer lugar, vamos a explicar cómo convertir la forma creada en inkscape en un 
componente de PCBNew. Para ello vamos a utilizar un script hecho en python disponible en: 
https://github.com/mtl/svg2mod. Es necesario que aclaremos, que con este script no solo se 
pueden generar bordes de placa, sino que se puede crear cualquier tipo de componente que 
necesitemos utilizar en PCBNew.  
Para más información de cómo utilizar el script consultar el Readme de Github. 
El proceso de creación de un borde de placa utilizando éste método es el siguiente: 
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1. Creación de la forma utilizando Inkscape 
 

 
 

Es muy importante que todos los elementos que utilicemos para crear la forma de placa 
sean trayectos, de lo contrario, el script no actuará sobre ellos. Para convertir un objeto 
a trayectos tenemos que ir a: 
 
Trayecto -> Objeto a trayecto (Ctrl+Mayus+C) 
 
Como queremos que la forma que hemos creado nos sirva de borde de placa, la vamos 
a colocar en una capa llamada Edge.Cuts y a continuación guardamos el archivo con el 
nombre “leds_dim.svg” en una carpeta llamada “silks” dentro de la carpeta contenedora 
de nuestro proyecto. 

 
2. Ubicación del script 

 
Una vez que tenemos la forma creada, tenemos que descargar el script mencionado de 
github y descomprimirlo. En la carpeta que se genera al descomprimirlo tenemos que 
situar una copia del archivo “leds_dim.svg”. 
 

3. Generar Componente para PCBNew (componente.mod) 
 

Abrimos el terminal de nuestro ordenador y accedemos desde él a la carpeta generada 
al descomprimir el archivo descargado de Github con el terminal. 
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Una vez en dicha carpeta, utilizamos los siguientes comandos para generar el 
componente: python svg2mod.py -i leds_dim.svg -p 1 -f 0.94 (hemos llegado a esta 
configuración probando diferentes combinaciones que hemos obtenido del archivo 
Readme del script, son los que a nosotros nos funcionan, no quiere decir que sean 
válidos para todo el mundo, os invitamos a que probéis otras configuraciones) 
Una vez ejecutado el script, en la carpeta donde hemos copiado el archivo 
“leds_dim.svg” aparecerá un un archivo con el mismo nombre, pero con extension 
“.mod”. Este archivo es el componente que contiene la forma de placa que hemos 
generado en Inkscape y que nos va a servir de forma de placa en PCNew. 
 
 

4. Añadir componente a PCBNew 
 
Antes de añadir el componente a PCBNew es necesario saber que tenemos que situar 
el archivo “.mod” en un lugar fijo, es decir, si añadimos el componente a PCBNew y 
posteriormente cambiamos la ubicación del archivo .mod, el componente en PCBNew 
dejará de ser utilizable. 
Para evitar que esto suceda, una solución puede ser: Crear una carpeta para 
componentes en “Mis documentos” en la que añadamos todos los componentes que 
vayamos creando. 
 
Con el archivo.mod en una su ubicación final, los pasos a seguir para añadir el 
componente a PCBNEW son: 

1. Abrir “Add footprint libraries wizard” en la pestaña “Preferences” 
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2. Ir a la ruta donde se encuentra el archivo.mod 
 

 
 

3. Comprobación de que el archivo se ha creado correctamente 
 

 
 

Si en esta ventana el estado no es OK, el componente se habrá creado mal y 
habrá que repetir el proceso de creado del componente. 
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4. Añadir el componente solo para este proyecto 
 

 
 

En este caso, como se trata de un componente que contiene la forma de esta 
placa concretamente, vamos a añadir el componente para que solo sea visible 
en este proyecto. En función del componente que creemos, se pueden añadir de 
forma global, y de esta forma, que sea accesible desde cualquier proyecto que 
creemos. 
 
 

5. Encontrar componente 
 
Ya tenemos el componente disponible para ser utilizado en PCBNew, solo nos 
queda encontrarlo, para ello vamos a utilizar la opción “Add footprints” 

 

 
 
Y en esta ventana seleccionamos “Select by Browser” 
Ya solo nos queda buscar en el menú de la izquierda el nombre de nuestro 
componente y cuando lo encontremos, hacer doble click sobre él en el menú 
central. 
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Borde de placa como DXF 
En segundo lugar, vamos a importar la forma de placa que hemos creado anteriormente en 
inkscape como un archivo DXF en PCBNew. 
Para ello, los pasos que tenemos que seguir son los siguientes: 

1. Exportar el archivo de KiCad como un archivo DXF, para ello vamos a: 
Archivo -> Guardar Como  
Aquí indicamos el nombre que le vamos a dar a nuestro archivo y en la extensión, 
tenemos que seleccionar la opción .dxf. 
 

 
 
A continuación pulsamos “Guardar” y nos aparecerá una ventana emergente, donde 
seleccionaremos las siguientes opciones: 
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2. Una vez que tenemos nuestro archivo DXF, todavía no podemos añadirlo a KiCad, 
porque, el archivo que inkscape genera es R14 y KiCad permite importar R12, por lo 
que tendremos que transformar el archivo generado. Para ello, vamos a utilizar 
librecad, (http://librecad.org/cms/home.html). Con este programa vamos a convertir el 
archivo en el formato adecuado en pocos pasos: 

 
Abrimos librecad y vamos a la ruta: 
File -> Open y seleccionamos el archivo que hemos creado con inkscape. 
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Cuando lo hayamos abierto, aparecerá nuestra forma de placa en la pantalla. Vamos a 
continuar seleccionando todo el dibujo y a continuación vamos a: 
Modify -> Explode. 
 

3. Para finalizar, vamos a guardar nuestro borde de placa en el formato correcto: 
File -> Save as  

 
Aquí tenemos que seleccionar la opción DXF R12. 

 
Con estos tres pasos ya tenemos lo necesario para poder añadir el borde de placa en PCBNew 
como DXF. Para añadirlo, solo tenemos que ir a la ruta: 
File -> Import -> DXF Files 
 

 
 
Aquí seleccionamos el archivo deseado, y al pulsar “Aceptar” no saldrá una ventana similar a la 
siguiente: 
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En ella, tenemos que seleccionar la capa “Edge.Cuts”, porque es un borde de placa (en caso 
de que fuese un silk u otro tipo de archivo podríamos seleccionar la capa correspondiente en 
“layers”) y donde y como queremos importarla, en este caso, hemos elegido definir el punto 
donde se va a posicionar. 
 
Al pulsar aceptar, el borde de placa quedará importado. 
 
Existe más información acerca de cómo crear este tipo de archivos e importarlos en KiCad en 
el capítulo 6 del manual de KiCad. (http://kicad-pcb.org/help/documentation/) 

 

Agujeros de fijación 
 
Ahora que tenemos delimitados los bordes de la placa, vamos a colocar los agujeros que 
servirán para poderla anclar a otra superficie. 
Para ello vamos a buscar un componente llamado: SolderWirePad_single_xxmmDrill, donde 
“xx” es el tamaño del dril. En este caso no es importante el diámetro que elijamos, puesto que 
lo vamos a modificar. 
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Para modificarlo, situamos el ratón en encima del componente y pulsamos la tecla “E”.  
 

 
 

En la ventana que se abre, vamos a modificar la medida del drill y la vamos a fijar en 3,5mm. y 
la del shape del mismo valor.  
Una vez seleccionado el tamaño, vamos a situar el componente. Para ello, podemos modificar 
las coordenadas en la ventana en la que hemos modificado el componente, o bien, 
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“arrastrarlo” y situarlo con el ratón, para lo cual, necesitamos situar el ratón encima del 
componente y pulsar la tecla “M”. 
Operaremos de la misma forma con el otro taladro. 
 

 
 
 
 

Colocado de componentes 
 
Situados los taladros para fijar la placa, vamos a empezar con la colocación de los 
componentes y el trazado de las pistas. Para ello necesitamos leer la Netlist que hemos creado 
anteriormente en Eeschema: Pulsamos sobre el icono Netlist y la importamos presionando 
“Read Current Netlist”. 
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Con ésto, nos aparecerán todos los componentes que hemos utilizado anteriormente para crear 
el esquemático unidos por finas líneas, que marcan las conexiones entre ellos. 
En primer lugar, vamos a colocar los LED. Para ello, vamos a fijar una distancia de separación 
aproximadamente 7mm.  
 

 
 

Cuando hemos colocado los dos LEDES centrales, para colocar el resto solo tenemos que 
conocer las coordenadas “x” e “y” de uno de ellos. Conocidas situaremos el ratón encima del 
siguiente LED a colocar y pondremos la misma coordenada “y” que el LED ya posicionado y la 
coordenada “x” sumándole 7mm. 
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En esa misma ventana, también hay que modificar la orientación de los LEDES, que será de 
-90º. 
                  Coordenadas D4                   Coordenadas D3  

                       
 
Procediendo de la misma forma con los demás LEDES restantes, llegaremos a una placa de 
estado similar a este: 
 

 
 

 
 
Como se ve en el renderizado 3D (View->3D Viewer o Alt+3), los LEDEs no están pegados a la 
placa, esto se puede corregir situando el ratón encima del LED y pulsando la tecla “E”. En la 
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ventana que aparece, seleccionamos la opción “3D settings” y dentro de esa pestaña, 
modificamos el valor del offset en el eje Z. 
 

 
 

  
 

Del mismo modo que con los LEDES procedemos a colocar el resto de componentes que nos 
quedan. 
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Rooteado 
 
Para rootear la placa vamos a seleccionar la opción “Add tracks and vias”. Esto nos va a 
permitir crear pistas de conexión entre los diferentes componentes, pero antes de empezar con 
las vías, tenemos que definir el tamaño de las mismas en: Design Rules -> Design Rules Editor 
-> Global Design Rules. En esta pestaña, vamos a poner un tamaño de pista de 0,4mm. 
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Teniendo el tamaño de pistas deseado, procedemos con el rooteado de la placa. 
 

 
 
Para seleccionar la capa de la placa en la que queremos situar la pista, cambiamos la selección 
de la capa en el menú de capas de la derecha. 
En caso de que necesitemos hacer una vía, podemos pulsar la letra “V” mientras se está 
haciendo una pista, o hacer “click” con el botón derecho del ratón y seleccionar la opción “place 
through via”. 

Empezando un proyecto con KiCad J. García - abierto.cc  

Sujeto a la licencia Reconocimiento-NoComercial-CompartirIgual 4.0 Internacional de Creative Commons
 

 

https://creativecommons.org/licenses/by-sa/4.0/


39 

 
Vamos a rootear todas las pistas, exceptuando las pistas de masa “GND”. 
 

 
 
Para rootear las pistas que quedan, que son las pistas de GND, vamos a crear planos de masa 
seleccionando la opción “Add filled zones”. 
Después, haremos “click” en cualquier parte de la pantalla y aparecerá la siguiente ventana: 
 
 

 
 
Donde primero vamos a seleccionar la capa TOP (color rojo) y GND, después de pulsar 
“Aceptar”, tendremos que dibujar un polígono que contenga toda nuestra placa. 
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Procederemos de la misma forma con el la capa BOTTOM (color verde). 
 

 
 
Ya solo nos queda hacer “click” con el botón derecho del ratón y seleccionar la opción “Fill or 
Refill all zones” o pulsar la tecla “B”. Con ello, se rellenará el plano que acabamos de construir 
uniendo todos los pines de conectados a GND. 
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Antes de continuar con los siguientes pasos, tenemos que verificar que lo que hemos hecho 
cumple con las reglas de diseño y que no nos hemos dejado ninguna conexión por hacer. Ésto 

lo vamos a hacer con la opción “Perform design rules check”.  . 
Al pulsar sobre el icono, se nos abre una ventana en la que tenemos que pulsar “Start DRC”. 
Cuando pulsemos, el programa hará una serie de comprobaciones y al finalizar tendremos una 
ventana como la siguiente: 
 

 
 

Si todo está bien, la parte inferior de la ventana estará en blanco. En caso de que hayamos 
cometido algún error en la ventana “Problems” aparecerá y al hacer doble click sobre él, el 
programa nos llevará hasta el punto donde se ha producido. Lo mismo ocurre si nos hemos 
dejado alguna conexión sin hacer, solo que aparecerá en la ventana “Unconnected”. 
Cuando en hayamos solucionado todos los errores que nos aparezcan tendremos todo lo 
necesario para generar los archivos “gerber” y mandar a fabricar nuestro PCB. 
En nuestro caso, antes de dar por finalizado el proceso de creación, vamos a añadir texto 
descriptivo que facilitará el montaje del PCB y su utilización, este texto recibe el nombre de silk. 
 

Silks 
 
El footprint de cada uno de los componentes está formado por diferentes partes: 

- Drills a través de los que hacemos las conexiones. 
- Parte gráfica, que indica cual es el tamaño del componente, es muy útil para hacernos 

una idea de lo que ocupan los componentes a la hora de situarlos. 
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Como se ve en el render de la placa, esa parte gráfica forma parte de nuestro diseño, es decir, 
cuando generemos los archivos gerber, va a aparecer en ellos, aunque ya no sea necesaria. 
Por este motivo, en primer lugar, vamos a borrar  las gráficas de los componentes, que, una 
vez situados, no necesitamos. Para ello vamos a editar el footprint del componente situando el 
ratón encima del componente que queramos editar y pulsando la tecla “E” y a continuación 
seleccionamos la opción “Footprint Editor”. 
 

 
 
Una vez aquí, vamos a borrar todas las líneas menos la exterior situada en la capa F.Silks 
(Silks de la capa TOP) 
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Además, también vamos a borrar tanto el nombre del componente como la referencia, para 
ello, situamos el ratón encima del texto y pulsamos la tecla “E”. En el menú desplegable que 
saldrá, solo tenemos que seleccionar la opción “invisible” en la sección “Display”. 
 

 
 

Para finalizar, vamos a seleccionar “Update footprint in  current board”       y saldremos del 
editor sin guardar los cambios. 
Repetiremos la misma operación con el resto de componentes. 
Para la red de resistencias, vamos a borrar toda la parte gráfica además del nombre y la 
referencia. Y lo mismo con el conector. 
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El resultado que deseamos obtener es el siguiente: 
 

 
 

Cuando tenemos la placa limpia de elementos que no necesitamos, vamos a crear el silk. Para 
crearlo existen varias opciones: 

- Utilizando la herramienta de texto del PCBNew   . Esta opción permite también 
añadir texto a en las capas de cobre, pero tiene varias limitaciones. Algunas de ellas 
son: El tipo de letra es por defecto, el texto en las capas de cobre queda delimitado por 
cuadrados… 

- Crear un componente con el silk o el texto que queremos añadir de la misma forma que 
hicimos con la forma de la placa. 

En nuestro caso, vamos a crear el silk y un pequeño texto en la capa de cobre para ponerlo 
como número de serie utilizando la segunda forma. Para ello, lo primero que vamos a hacer es 
exportar el PCB en formato SVG. File->Export SVG. 

Empezando un proyecto con KiCad J. García - abierto.cc  

Sujeto a la licencia Reconocimiento-NoComercial-CompartirIgual 4.0 Internacional de Creative Commons
 

 

https://creativecommons.org/licenses/by-sa/4.0/


45 

 
 

A continuación, vamos a modificar el archivo SVG generado, añadiendo el número 
correspondiente a cada LED en el conector, y a que pin corresponde el GND. 
 

 
Una vez lo tengamos, vamos a quedarnos solo con el texto que hemos añadido, lo convertimos 
a trayecto, de la misma forma que lo hicimos cuando creamos el borde de placa y lo vamos a 
situar en una capa llamada “SilkS” y generamos el componente utilizando el script. 
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De la misma forma, vamos a crear un componente que sea un texto en la capa de cobre. Para 
ello, vamos a crear en Inkscape el texto “abierto.cc” y lo vamos a situar en una capa llamada 
“Cu”.  

 
 
Una vez los hayamos creado, los importamos a PCBNew y los añadimos a la placa. 
 

 
 
Al crear el componente sobre la capa de cobre obtenemos el siguiente resultado: 
 

 
 

Donde podemos observar que el plano se ajusta al texto. 
El resultado final de la placa es: 
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Archivos Gerber  
 
Los archivos Gerber son los archivos que el fabricante de PCB necesita para fabricarlo. Antes 
de generarlos, vamos a crear una carpeta en la carpeta contenedora de nuestro proyecto, de 
nombre “gerber”. 
A continuación vamos a File -> Plot.  
En la ventana que se nos abre vamos a seleccionar las siguientes opciones: 
 

 
 
Cuando tengamos esta configuración pulsamos “Plot”, con esto se generarán los archivos 
correspondientes a las capas de cobre y silks. Solo nos queda generar el archivo con los 
taladros. Para generarlo, pulsamos la opción “Generate Drill File” y configuramos la ventana 
que se abre de la siguiente manera. 
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Cuando tengamos la configuración adecuada, presionamos Drill File y generaremos el archivo            
de taladros que necesitamos. 
 
Este es el último paso a realizar para fabricar nuestra placa PCB, mandando los archivos               
Gerber que acabamos de generar al fabricante, éste tiene todo lo necesario para faricar el               
PCB. 
 
En el programa GerbView, podemos comprobar que los archivos Gerber han sido bien             
generados. 
 
¡Enhorabuena!  
 
Ya has fabricado tu propio PCB. 
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